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1. Setting Up Your New eCivis Account 

1.1. My Account Information page 
When you initially log into eCivis Grants Network, you will be taken to the “My Account 

Information” page. Here, you can change your Account Email Address, Password, User 

Profile Selections, and Contact Information: 
 

 

 

You can also see to which user groups you are assigned, and which departments you are 

assigned on this page: 
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After you have confirmed that information on the My Account Information page, and edited 

any fields you wish to edit, click the checkbox that reads “I have verified my contact 

information to be current and accurate.” You may also check or uncheck the “I do not wish to 

receive promotional materials” box at this time: 
 

 

1.2. My Preferences Page 
When you click “Save” on the My Account Information section, you will automatically be 

taken to the My Preference page. This page allows you to personalize the way your Grants 

Network account appears, and how you receive information. 

 

The Display Preferences section determines how many grants you will see listed when you 

perform a Grant search in the Grants Database within Grants Network. Use the drop-down 

menu to make your preference selection: 
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The Email Preferences section allows you to determine how often you wish to receive various 

types of email messages from your eCivis Grants Network account. Click the radio buttons 

beside each email type to determine if you want to receive the emails daily, weekly, or not at 

all: 
 

 

- New Grants / Updates Email: This email will inform you of any new grants or grant 

updates that enter the eCivis Grants Database. 

 

- Saved Grants Email: This email alerts you if an update has been made to a grant you 

have saved (eg: a due date has changed, or the contact information has been updated). 

 

- Search Agent Email: This email informs you if any new grants have been added to the 

eCivis Grants Database that match your saved search agent filters. 

 

- Tasks Email: This email sends you an email if you are assigned a task in Grants Network, 

and/or if you have any overdue tasks that have yet to be completed. 

 

- Routed Grant Updates Email: This email informed you if a grant has been sent to you by 

another users for review. When this occurs, a review task is created for you to ensure 

that you see a grant that another user thinks may be relevant to the project(s) you are 

currently trying to fund. 
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Once you have selected your preferences above, click “Save.” This will take you back to the 

eCivis Grants Network Homepage, which will be the first page you see going forward 

whenever you log into Grants Network. 
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2. Setting Up Your Funds for Solicitation 
The purpose of this first step is to locate or create the source of funding for the solicitation and not 

the solicitation itself. For instance the source of funding could be a Federal grant where you are 

acting as the pass-through agency (read Setting up a Grant Fund below). Or it could be General Fund 

dollars from a special tax, etc (see Setting Up Your Non-Grant Fund below). It can even be a mix of 

funds that include each of fund type. In which case, these sources and can be blended and braided 

yet delineated to the dollar in your Subrecipient Management tool. That is why the first step of any 

program solicitation is to create and enable your funding in eCivis for solicitation. 

2.1. Setting up a Grant Fund 
Grant funds that are to be solicited for application must first be set up as an award in eCivis 

from the position of being a grantee. This begins with setting up your grant funding source in 

a project. 

 

NOTE: If the source of funds is a Grant program that has not yet been saved to a project, 

continue to Locating Your Grant in the Research Database. If the Grant has already been 

saved to a project and advanced to the Grant Awarded stage, continue to Creating a New 

Program. 

2.2.1. Locating Your Grant in the Research Database 

1) Select the Research button on the top left side of the home page and locate 

your grant using keywords or a CFDA number for Federal grants: 
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2) Your grant results will appear as a list with the following headers: 

 

 

1. Score: A score eCivis gives grants based on how well they match your 

search criteria. 

 

2. Grant Title: Title of the grant 

 

NOTE: If you hover over the grant title, you will see a preview of the grant 

information that will help you make a decision about whether the 

program details match your grant that you are trying to enter: 
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3. GN Code: A unique code given to each grant in the eCivis Grants 

Database by eCivis. The following prefixes indicate different types of 

grants: 

- US: Federal grant 

- FD: Foundation 

- State Abbreviation (eg: CA, WA, NY, etc): State grant 

 

4. Agency: What agency created the grant solicitation. 

 

5. Actual Funds: The amount of funds available from the grant. 

 

6. Due Date: Grant application due date 

 

3) If you wish to edit any of the search criteria and perform another search, you 

can do so by clicking into the fields to the left of your grant search results, 

and clicking “Apply Filter”: 

 

 

4) The following search criteria will appear: 
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1. Categories: All grants that are in the eCivis Grants Database are 

categorized for easy search. 

 

2. Grant Type: Select any or all types of grants that you want to search (eg: 

If you are looking specifically for Federal grants, select “Federal” in the 

available menu). 

 

3. Agency: When you select the grant type, the Agency menu will show you 

additional agencies within each grant type (eg: You can search for only 

grants offered by the U.S. Department of Health and Human Services 

within Federal grants). 

 

NOTE: If you click the “Include Organizational Funding” box… 

 

If you click the “Include Archived Grants” box, your grant results will 

include grants that have not been updated in recent years, and grants that 

have newer versions available (eg: 2019 vs. 2020). 

 

4. Eligibility: Select the types of grants for which you are eligible. 

 

NOTE: you are a local government organization, but you are working with 

a Native American Tribe, you are eligible for Native American Tribe 

grants. This is the case with all multi-organization projects; they are 

eligible for all grant types of all organization parties. 

 

5. Due Date: Designates the due date of the grants you want to appear in 

your search results. You can click “Geo Filter” to filter out grants that you 

are not eligible based on state/organization location. 

 

6. Matching: Allows you to filter for grants that include matching funds, 

don’t have matching fund requirements, grants where matching funds are 

recommended. 

 

5) After you have set all of your search filters, click “Find Grants Now” again to 

view your results: 
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2.2.2. Entering a Grant Not Found in Research 

If you ever wish to add funding from a grant that cannot be found in the eCivis Grants 

Database, you can do so using the following steps: 

1. From the Grant Research Tab, select “Organization Funding.” 

 

 

2. Using the Search bar above the table, if you can find a previous fiscal year of 

the grant you wish to set up, then click the “Duplicate” icon under the Actions 

column to save time on set up. Skip to Saving/Assigning Grant Fund to a 

Project if so. If you do not find a previous year, continue with the following 

 

 

a. Confirm that you wish to duplicate this grant: 
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b. Update the fiscal year, title, and any other outdated details: 

 
 

 

c. Click “Save”: 

 

 

d. You will now see the duplicate grant in your Public Organization 

Funding list: 

 

 

3. To start your grant from a blank template, click the “Add Org Funding” button: 
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4. Select whether the funding type you are adding is Competitive or Non- 

Competitive: 

 

 

5. If you select “Competitive Funding,” the following Funding Identification and 

Application/Financial fields will appear. Be sure to fill out all required fields: 

 

NOTE: If you select “Non-Competitive Funding,” the Application/Financial 

section above will look like this: 

 

 

This is the only difference in the fields that appear after you select 

“Competitive Funding” or “Non-Competitive Funding.” 

 

6. After you fill out the Funding Identification and Application/Financial fields, 

continue to the Summary section. This section is not required, but 

recommended. This way, you can be certain where the funds come from, and 

their intended purpose: 
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7. Select the Categories and Eligible recipients of your funding. 

 

NOTE: This process of creating funding in your eCivis Grants Network 

account is very similar to the process eCivis uses to add grants into the Grant 

Database: 

 

8. If the funding you are adding has a website, you can add that URL in the 

“Reference URL” field. Immediately under the Reference URL field is a place 

where you can add any accompanying documents to your funding (eg: 

NOFAs, news articles, etc). 

 

 

9. When you have added all of the information for your funding, click “Save.” 

 

10. You will be taken to the Organization Funding page, where your new funding 

source will be listed under “Public Organization Funding.” 

 

Note: Your funding source will automatically be given a GN code beginning 

with the prefix “ORG” (or a custom prefix) + a number corresponding with how 

many funds have been set up in Organization Funding to date: 
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11. To the far right of your newly-added funding source, you will see five icons: 

 

 

1. Save/Assign Grant: Save the grant to a specific project, or to the 

unassigned saved grants section of Grants Network. For more detailed 

information about the Save/Assign Grant process, see section 5.7.1 of 

this user guide. 

 

2. Edit Grant Information: Change fundamental information about the grant 

such as Title, Fiscal Year, and more. 

 

3. Delete Grant: Delete the grant. 

 

4. Archive Grant: Archive the grant for later use. This is helpful if the grant is 

not yet ready to be used, but will be in the future. 

 

5. Duplicate Grant: Make a copy of an existing grant. 

 

2.2. Saving/Assigning a Grant Fund to a Project 
Whether in the Research tool or Organization Funding page, the grant fund is then assigned 

to a department and project using the “Save/Assign” button. The project dashboard allows 

you to manage all aspects of your grant agreement with your Funding Agency and the 

solicitation you create will draw funds from this project. 

1) Click on the Floppy Disk “Save/Assign” icon to save the grant to a project: 
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a. Example from “Grant Research”: 

 
 

b. Example from the “Organization Funding” page: 

 

 

2) Select “Assign grant to a new project”: 

 
 

 

3) On the “Assign Grant to New Project” form, complete the fields (fields with red 

asterisks are required), beginning with the project dashboard details: 
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1. Department: Select the project department from the drop-down menu. 

 

2. Project: Name the project after the grant title and add any important 

naming conventions like the program fiscal year. 

 

3. Project Lead: Select a program manager or other departmental authority 

from the drop-down list of department members. 

 

4. Project Type: Indicate if the project is a Construction or Non-Construction 

project. 

 

5. Internal Project ID: This field is not required and not typically filled on 

pass-through funds. If your financial system is integrated with eCivis, this 

field helps route expenditures made against this grant account to display 

in this project for reporting purposes. 

 

6. Internal Project Name: This field accompanies the Internal Project ID to 

provide the account name or nomenclature used to name this grant 

 

4) Select “No” for your answer to “Is an application required for this grant?” And Select 

the Grant Status: 

 

 

5) Fill in the required details of your grant award marked with red asterisks. 
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6) If there is a match required, enter the Cash and/or In-Kind Amounts: 

 

7) Select any Grant Tags that apply to your grant: 
 

 

 

 

8) Be sure to mark the grant as “Pass-Through Funding” and NOT as “available for 

allocation to sub-projects”: 

 

 

9) Upload any award notice or award agreement files by clicking the folder button: 
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10) Click “Save.” 

 

11) You will now have a Project Dashboard devoted to this grant and can proceed to 

build your program to draw from these funds. 

 

NOTE: For more information on managing your grant as a grantee with project 

dashboard tools, refer to the Grantee Pre-Award and Grantee Post-Award User 

Manuals. 

 
 

 

2.3. Setting Up Your Non-Grant Fund 
Non-grant funds such as tax-based, general funds, or donations are entered into and 

managed within the Funding Sources page, an Organization-wide funding list that serves as 

an alternative to setting up a project. 

NOTE: This page is only manageable by Organization Master Account Holders (OMAH). If you 

are a Department Master Account Holder (DMAH) or Departmental (Dept) Staff, you may 

communicate with an OMAH to set up your fund and add your name to the users who can 

use this fund in solicitations. 
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1) Under the Administration menu, select Funding Sources: 

 

 

2) Search and review previous entries to ensure you will not create a duplicative entry. 

You can expand the number of listings per page as needed: 

 

 

The sections of the page are as follows: 

 

1. Title of Funding Source. 

 

2. Total initial amount of the funding source. 

 

3. Funding remaining after deducting pass-through amounts used in 

solicitations. 

 

4. Number of solicitations that utilize funds from this source. 

 

5. Allocation Permission: Whether funds are allowed to be used for program 

solicitations. 

 

6. Take an action on the fund and edit it’s details and permissions. 

 

7. Expand the number of records shown on one page to reduce the need for 

page flipping. 

 

8. Search existing funding sources by keyword to view/edit. 
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9. Add a new Funding Source. 

 

3) If you have not already created your fund, click “Add Funding Source” in the upper left 

corner. 

 

4) Enter the following fields pictured below: 

 

 

1. Title of account to display system-wide. 

2. An identification number used internal to refer to this fund. 

3. Total amount to be available in this account. 

4. Enable or Restrict this fund from allocation to program solicitations. 

 

5. Select users who will be allowed to manage this fund and use it within 

program solicitations. When editing a solicitation, the approved users will 

see this fund as an option to fund their solicitations. 

 

6. Leave any important notes with regards to this fund. 

 

7. Click “Save.” 
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3. Creating a New Program 
Once you have your grant fund set up in a project or, if another type of fund, in your Organization’s 

Funding Sources page, you may proceed to create your public solicitation. 

1) Under the Grants Management menu, select Subrecipient Management 

 

2) You will be taken to the Subrecipient Management Program Dashboard where all 

solicitations are managed from conception to publishing, awarding, and closing. You can 

search and review previous entries to ensure you will not create a duplicative entry. The 

Program Dashboard contains the following elements: 

 

 

1. Add New Program: This button will launch a new solicitation draft. 

 

2. Public Solicitations Listing Page: This will take you to view your organization-wide 

listing of public programs which are stored in a single webpage. This webpage 

can then be shared or embedded in an existing webpage such as your 

organization’s website. With each new solicitation, you will set a preference for 

that solicitation to be excluded from this page or not. 

 

3. Your Pending Approval Tasks: A table of your personal pending tasks on all 

programs. 
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4. Program Solicitations: A table of all program solicitations where you can perform 

any necessary actions from the actions column. You can search existing 

programs before creating a new one. 

 

3) Click “Add New Program” and fill the required details: 

 

1. The name of your new program which will display both internally within eCivis and 

externally to applicants. 

 

2. Set the solicitation to Public or Private: 

 

Public will place your program on the Public Solicitations page. This page 

is a linked listings webpage created by eCivis that you can promote for 

potential applicants to view your available programs. 

 

Private will not place your program on the Public Solicitations page and will 

restrain your solicitation sharing to just individual program links 

 

3. Click “Create Program.” 
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4. Editing Your Solicitation Details 
Editing your solicitation begins with the Program Detail Page. The Program Detail Page is where all 

information pertaining to a publicly or privately solicited program is stored, including specific 

program solicitation information, award amounts, sub-award information, pending and completed 

tasks as well as reports. 

 

To access (or create) your solicitations in eCivis Grants Network: 

1) hover over the Grant Management tab, and click on “Subrecipient Management”: 

 

 

2) From this page, you can Add a New Program (Program Solicitation), or view your Public 

Solicitations Listing Page: 

 

 

3) You can also view any Pending Approval Tasks, such as Financial Report approvals, on this 

page. This is a function of the Grantor Post-Award phase, but it is viewable here: 
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4) You can also view your existing Program Solicitations at the bottom of this page: 

 

 

1. Department: The department from where your solicitation funds originate. 

 

2. Title: The title of your program solicitation. You can click on this to access more 

program solicitation details. 

 

3. Status: The status of your program solicitation (Draft, Published, etc.). 

 

4. Total Funding: The amount of funds available for your program solicitation. 

 

5. Actions: Opens up a menu of available actions with the program solicitation: 

 

 

The options in the Actions drop-down menu include: 

 

- View detail: This option will bring you to the Program Details page above to 

manage all aspects of this program. 

 

- Edit Solicitation: This option will bring you to the Edit Solicitation page to view/edit 

the details which are informational and instructive to prospective applicants. 

 

- Create App Workspace: This option is used to submit your solicitation draft when 

finished editing it. This will result in the creation of a Zengine workspace which is the 

system used to customize application forms and review scoring forms as well as to 

manage your reviewer process and award recommendations. 

 

- Delete: This will remove this program permanently from eCivis. 
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4.1. Program Detail Page 
1) To view the details of a program solicitation you have created, scroll down to the 

bottom of the Program Dashboard page, locate the program you wish to view, and 

click on the Title: 
 

 

2) This will take you to the Program Detail page. 

3) The top section provides specific information about the funding department, amount 

of available funds, and application period: 

 
 

4) The Award Recommendation Approvals section shows pending approvals for 

applicants who have been recommended to receive funds by the reviewer team, but 

have not yet received final approval to be granted funds: 

 

 

5) The Pending Awards section shows the status of all pending award 

recommendations: 
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4.2. Edit Solicitation 
Editing the details of your solicitation program in eCivis Grants Network is simple. 

1) Click the “Edit Solicitation” button on the Program Detail page of the program 

solicitation you wish to edit: 

 

 

2) Complete each section which will provide details and instruction for prospective 

applicants and will manage the system features used in your solicitation. Each 

section heading is marked with a red “X” indicating that it is incomplete. The icon will 

change into a green checkmark when completed and saved: 

 
 

NOTE: You can also access this page from the Actions menu on the Program 

Dashboard page by selecting “Edit Solicitation”: 

 

 

4.2.1. Edit Solicitation – Overview Tab 

The first step in editing a solicitation is editing the Overview Tab. If this tab is 

missing required information, it will have a red X on it: 
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1) Title: The program name that was set up initially and which will be visible to 

applicants. 

 

2) Application Start Date: This date indicates when applications can be 

accessed in eCivis portal to begin drafting a submission. There will be no 

“Apply” button on the solicitation announcement page until this date. 

 

3) Application End Date: This date indicates the end the application period and 

the “Apply” button will disappear applications can be accessed in eCivis 

portal to begin drafting a submission. 

 

4) ID: Indicate any alphanumerical identifier used to identify this program 

externally and internally. 

 

5) CFDA: Indicate the Code of Federal Domestic Assistance (CFDA) number for 

your federal funding source. 

 

6) Reference URL: Provide viewers a link to another informational webpage. 

 

7) Listing Availability: Manage your initial preference for setting this program to 

public or private. (Remember: selecting public will place this program on your 

Public Solicitation Listings page). 

 

8) Summary: Build your detailed summary about this program and its purpose 

using the text formatting tools as needed. A blue status bar below the 

summary box will measure how close you are to reaching the maximum 

character limit. 

 

9) Click “Save” to mark this section complete. Then click the “Eligibility” or any 

other section heading you wish to edit next. 
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4.2.2. Edit Solicitation – Eligibility Tab 

 
1) Select who is eligible to apply for your program solicitation by checking the 

applicable box(s). 

2) Add any notes about eligibility of applicants in the Eligibility Notes sections. 

You can use the buttons on top to format this text however you like. This 

includes adding HTML formatting. 
 

 

 

4.2.3. Edit Solicitation – Financial Tab 
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1) Start by making a selection in the Total Funding section. 

 

Click “Add Funding Source” to add funds from a grant or grants to fund this 

program solicitation: 

 

Select either Organizational Funding Source or Pass-Through Funding 

Source: 

 

 

Based on your selection, click the drop-down menu beneath Select Funding 

Source, and choose a fund or grant from which to allocate funds: 

 

 

Based on the fund or grant that you choose, you will see the Total Available 

funds. Type in the amount of the available funds you wish to allocate to this 

program solicitation in the Total Allocation field, and click “Save Funding”: 

 

 

Once you have added all of your funding sources, you can click “Assign 

Default Payment Allocation.” This button will open a menu that lets you 

define the default payment for each program funding source: 
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2) Select the Yes or No buttons to indicate if the Total Funding Amount will 

display on the final solicitation page: 
 

 

3) Select the Yes, No, or Recommended button to indicate whether there is a 

match required from Subrecipients to qualify for your program funds: 

 

 

4) Enter the range of the available award amount (optional) that will display to 

prospective applicants. This includes a minimum and maximum amount: 
 

 

5) Indicate the Number of Awards available: 
 

 

6) Indicate the Average Award Size that will be displayed on your solicitation: 
 

 

7) In the Financial Notes section, include details about the financial aspect and 

requirements upon subrecipients using the text formatting tools as needed. A 

blue status bar below the summary box will measure how close you are to 

reaching the maximum character limit: 
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NOTE: You may use the buttons above the text field to format your text. 

 

4.2.4. Edit Solicitation – Contact Tab 

 
1) Office: Include the name of the office issuing the solicitation. 

 

2) Program Contact: Include contact details for the person applicants should 

contact with questions about the solicitation. 

 

3) Application Address: Include the address of the office receiving applications 

digitally or physically (in cases where physical supplemental materials are 

required from applicants). 

 

NOTE: Check the checkbox between the Program Contact and Application 

Address fields if the address and contact info are the same: 
 

 

4) Contact Notes: Include details about the use of the given contacts using the 

text formatting tools as needed. A blue status bar below the summary box 
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will measure how close you are to reaching the maximum character limit. 

 

5) Click “Save” to mark this section complete. 

 

 

4.2.5. Edit Solicitation – Files Tab 

 
1) Current Files: Where you will add all supplementary documents that 

applicants may need to understand and apply for your solicitation. 

 

Click “Add File” to add documents: 
 

 

Click the drop-down menu below File Label to select the type of file you are 

adding: 

 

mailto:support@ecivis.com


P a g e | 

34 

Customer Success | 418 N. Fair Oaks Ave., Ste. 301| Pasadena, CA | (877) 232-4847 | support@ecivis.com 

 

 

Click “Choose File” to select the file you wish to add. After you have selected 

your file, click “Upload File” to save. 

 

NOTE: If you added a file by mistake, you can remove it by clicking the trash 

can icon beside the file in the Current Files section: 
 

 

2) Application Submission Notes: Include details about how to apply, what to 

include, and anything else you need to communicate to applicants. Use the 

text formatting tools as needed and a blue status bar below the summary box 

will measure how close you are to reaching the maximum character limit. 

 

3) File Notes: Include details about the use of the included files using the text 

formatting tools as needed. A blue status bar below the summary box will 

measure how close you are to reaching the maximum character limit. 

 

NOTE: You may use the buttons above the text field to format your text. 

 

4) Click “Save” to mark this section complete. Then, click the next section or any 

other section heading you wish to edit next. 

 

4.2.6. Edit Solicitation – Review Tab 
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1) Add your Review Committee members by clicking “Add Reviewer”: 
 

 

This will open a pop-up where you can add the First Name, Last Name, and 

Email Address of the reviewer: 

 

 

Click “Add Reviewer” to continue. 

 

NOTE: You can remove a reviewer by clicking the trash can icon beside their 

name in the Review Committee section: 
 

 

2) Review Notes: Notes in this section will alert eCivis service and support of 

any special requests you have for your application review process. 

 

For example: You may request that certain listed reviewers be alerted 

whenever a new application is submitted. 

 

NOTE: You may use the buttons above the text field to format your text. 

 

3) Click “Save” to mark this section complete. 
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4.2.7. Edit Solicitation – Submission Tab 

In the Submission Tab, you will manage important settings for your submission and 

subrecipient portal. This section is NOT visible in your external solicitation page. 

 
 

 

1) Primary Workspace Email: Enter an email for the primary program 

administrator to be the first one set up in your Zengine workspace where 

application forms are built and submissions managed. 

 

2) Accept Multiple Applications Per User: Select whether you want to allow 

applicants to submit more than one application on this program for multiple 

projects. 

 

3) Budget Development: It is recommended that you use the budget tool in your 

application rather than leaving applicants to upload a budget spreadsheet. 

Doing so will allow you to include the applicant’s final budget details in their 

award acceptance packet and to track spending against this budget. 

 

Select “Yes,” if you will include Budget Development 

 

If you have selected “Yes,” you will need to select the desired budget template 

that applicants will use to submit their budget proposals: 
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4) Track program income with Finance Reports: Selecting this checkbox will add 

a program income field to the financial reports that subrecipients submit. 

Select whether their program income should be tracked as additive to their 

award, subtractive to their award, or applied to their match. 

 

5) Permit allowable 10% budget adjustment without award modification: When 

checked, you can check the second box to enable a notification when a 

budget adjustment is made below the 10% threshold. If this option is left 

unchecked, then subrecipients will not be permitted to adjust their budget by 

even the smallest amount without submitting an accompanying grant 

amendment request. 

 

6) Submission Notes: Notes in this section will alert eCivis support of any 

special requests you have for your submission process. You will at least want 

to leave notes indicating: 

 

- At what exact time you wish the application deadline to take effect and no 

longer receive applications. (Be sure you have indicated any such time in your 

Application Submission Notes section of the Files tab. 

 

- If your program Listing Availability is set to Private, you may indicate if you 

would like your program to be published and ready to share as soon as it is 

set up by eCivis support. Otherwise, you will be responsible for alerting eCivis 

support by email when you have finished making any edits to your application 

form and are ready for the solicitation to be published. 

 

- Any other team member (names and emails) to include on your Zengine 

program workspace for managing this application process. 

 

NOTE: You may use the buttons above the text field to format your text. 

 

7) Click “Save” to mark this section complete. 
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4.2.8. Edit Solicitation – Goals Tab 

In the Goals tab you can enter the goals you have for your program. These goals will 

be included in the application and post-award process: 

 

 

1) Click “Add New Goal” button to add a goal. 

 

2) Add Goal Title. 

 

3) Add Target Amount. 

 

4) Click “Save.” 

 

5) Under Actions, you can Edit Goal or Delete Goal. 
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4.2.9. Edit Solicitation – Approval Tab 

In the Approval tab, you will define an approval workflow for crucial task events in 

your program lifecycle including any documents the subrecipient will need to 

complete the award acceptance process. Click the pencil icon next to each Task 

Type to define a workflow. 

 

 

1) Click the pencil icon beside the Task Type you wish to configure. This will 

open a pop-up: 

 

 

2) Select your Approval Type by clicking the corresponding button. 

 

Standard is used for individual approvers and for Standard groups which 

notify all group members simultaneously and require that any one of the 

members respond to the approval request. 
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Sequential is used only for groups, and specifically for Sequential groups 

which move from one approver to the next in a sequence that is indicated in 

the Group Manager settings. 

 

3) If you selected “Standard,” you will need to designate an approver. This can 

be either a specific User, or a User Group. 

 

For a single User approver, click the button beside “User,” and select the 

Department and the User Name: 
 

 

For a User Group, click the button beside “User Group,” and select the User 

Group: 
 

 

4) Click Save to continue. 

 

5) Proceed through each Task Type by clicking each pencil icon, and repeating 

the steps above. Each Task Type is described in detail below: 

 

- Award Recommendation Approval: Triggers when an award 

recommendation is created in Zengine and then award details are requested 

for internal approval within your Subrecipient Management dashboard. The 

applicant is not notified of their award offer until the final approval is given on 

this request. 

 

- Final Award Approval: Triggers when an award has been accepted by an 

applicant. This is the final approval before the award is considered awarded. 

 

- Grant Amendment Approval: Triggers when a subrecipient requests a grant 

amendment. 

 

- Grant Amendment Approval with Finance: Triggers when a subrecipient 

requests a grant amendment containing a financial change. 

 

- Financial Report Approval: Triggers when a Financial Report has been 

submitted by the subrecipient. When defining the workflow for a submitted 
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report, additional options are available to indicate: 

 

Instructions on how the subrecipient should complete their report and what 

to include in the way of notes, attachments, etc: 

 

The Frequency of assigned Financial Report Tasks. Select the intervals, due 

dates, and the reporting period start and end: 
 

 

- Activity Report Approval: Triggers when an Activity Report has been 

submitted by the subrecipient. 

 

6) To add documents for subrecipients to complete during the award process, 

click “Add File” in the Award Files section and upload a file: 
 

 

NOTE: You can delete files you have added by clicking the red trash can icon: 
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7) Click “Done” to complete the Solicitation edits: 
 

 

4.2. Complete Intake Form 
Once your solicitation is complete, please be sure to check all information is correct and 

accurate. After your solicitation has been reviewed, the next step is to complete the Intake 

Form. This form is a required step in the process for those creating a standard competitive 

application using the RI Standard Template. (This is not required if you selected a custom 

template.) The Intake Form allows you to begin to customize your application workspace 

based on the RI Standard Application. eCivis will use the information in your Intake Form 

to create your application workspace. 

1) Click this link https://webportalapp.com/sp/login/dqf6wmu0aa 

2) If you have not completed an Intake Form before, click Sign Up. If you have 

completed an Intake Form before, Log In. It is recommended that you use the same 

username and login as eCivis. 

3) If this is your first time using the Intake Form, click the Profile box and 

complete the profile until it shows “Complete”. 

 
4) Then click the + Add Another” box below the Profile to start your Intake Form 

for this program 
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5) Complete all questions of the Intake Form, Program Setup section. The form will  

ask you what optional questions you want included in your application, and if there  

are any files you want included in your application. It will also ask you how you want  

to score some of the required questions in the application.  

 

6) Once complete, click “Mark as Complete” at the bottom of the page and move  

onto the next step.  

 

4.3. Create Your Application Workspace 
Once your solicitation editing is complete, you are ready to create an application workspace 

within Zengine. This begins by submitting your solicitation to eCivis and awaiting an invite to 

your new workspace. 

7) On the Program Dashboard, locate your program title and click the Actions button to 

the right of your program. 

 

8) Select “Create App Workspace”: 

 

9) Select “Yes” if you are ready to submit and confirm the budget setting and template 

you have selected: 

 

 

10) Your program will be marked as “Under Review” until it is configured in Zengine by 

eCivis Support, and until the date/time you have requested that your solicitation 
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officially publish: 
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5. Finalizing Your Application and Review Forms 

5.1. Accessing the Workspace 
1) Once you have selected to Create an Application Workspace, the Primary Workspace 

Owner indicated in the solicitation will receive a confirmation email of the solicitation 

details: 

 

2) When the Primary Workspace Owner receives their invitation to the workspace, they 

will click to accept the invitation. Once they have accepted the invitation to the 

application workspace, they can review and edit the application form, review form, 

and add additional users to the workspace: 

 

 

3) Log into Zengine if you have an account. If you do not, then enter your email and click 

continue to create a new account: 
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OR 

 

 

4) Select the workspace title that matches the program title you wish to access: 

 

 

5) You will be taken into the workspace Data page where you can edit your forms and 

view submitted applications, budgets, and reviews among other submission data. 
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These forms include: 

 

 

1. Application form 

 

2. Review form 

 

3. Reviewers Assigned 

 

4. Budget Submissions 

 

5.2. Adding Additional Users to the Workspace 
1) Click the Settings gear icon: 

 

2) Click on the “Members” tile: 
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3) Click the “+Invite Members” button: 

 

 

4) Fill out the Invite New Members to this Workspace form: 

 

1. Enter the email of the invitee(s). 

 

2. Assign the level of view/edit permissions you wish to assign to this individual. 

 

3. Click Send Invite and they will receive an invite to join the workspace and to 

create a Zengine account if they have not already done so. 

 

5) When finished, return to the workspace Data page by clicking the Data icon: 
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5.3. Editing Your Application Form Content 
1) From the Data page, ensure that you are viewing the Applications tab: 

 

 

2) On the top-right corner of the Applications table, click the Form Tools button and 

select “Edit Form”: 

 

Prior to publishing your solicitation you can add custom help text and optional or 

mandatory file uploads. Help text will appear to the applicant directly above the field 

and can be used to general describe the purpose of the field. 

 

NOTE: Do not edit any of the fields with the “Linked from” (chain link icon) label such 

as the “Profile” field. 

 

NOTE: Do not delete any of the required fields displaying a red asterisk (*) that are 

part of the default fields in your application. 
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3) Select the “Edit” button for the desired field: 

 

 

4) Select “See advanced options” and enter desired text in the “Help text” box: 

 

 

5) Enter text in the “Help text” box: 

 

 

6) Use the “Validation Options” to set character or word count limitations: 
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7) New fields can be added through the panel on the right-hand side called "Drag and 

Drop Fields." As the name implies, fields are adding through dragging the chosen 

field over to the form builder on the left and dropping it in the spot you would like this 

field to appear on the form. 

 

The following is an explanation of each form field type: 

 

- Text: Allows for input of a short amount of text, typically one line, such as name, 

email address, or phone number. 

 

- Text Box: Allows for input of a longer amount of text, such as an address or a short 
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essay. 

 

- Dropdown: Allows for a user to select from a pre-determined list of options 

presented as a dropdown. Settings can allow users to be able to select just one or 

multiple options. 

 

- Checkbox: Allows for a user to select from a pre-determined list of options 

presented as checkboxes. Users can select multiple options. 

 

- Radio Button: Allows for a user to select from a pre-determined list of options 

presented as radio buttons. Users can select only one option. 

 

- Number: This field type can be configured to allow for a number with a 

predetermined amount of decimal places (such as a GPA) and/or a currency. 

 

- File Upload: Allows for a user to upload documents and media. File types and sizes 

can be restricted. 

 

8) For file uploads drag and drop the “File Upload” icon into the desired location on the 

application form and rename the field appropriately: 

 

 

9) To make the file upload required for applications, select the “Edit” button, and check 

the “Required” box: 

 

 

10) You can create rules and conditions for each field using the “Edit Field Rules” button. 

 

For example, you can create a condition where this field only appears if the prior 

question was answered with the value “Yes.” 

 

 

Click the Add a Rule button, and rule logic options will appear: 
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11) Help text, file uploads and/or character limitations can be added in the same way as 

the Applications tab. Refer to this section for instructions: 

 

 

5.4. Creating the Review Form 
This form will be used by your assigned reviewers to view and score applications. The form 

will typically consist of long-form responses and scoring questions that prompt the reviewer 

to enter a numerical value 

1) From the Data page, select the Review tab: 

 
 

2) Select “Forms Tools” and “Edit Form” to edit the Review form: 

 

 

NOTE: See section 5.3 for help with adding fields using the drag-and-drop tools as 

well as instructions for adding help-text. 
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3) To set the weight of a specific numerical field, first indicate clearly in your question 

or help text what is the acceptable value range. Then set a minimum and maximum 

in the Validation Options section. 

 

4) Click the Edit button on the field: 

 

 

5) Click “See Advanced Options”: 

 

 

6) Enter minimum and maximum values: 
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6. Publishing Your Solicitation 
After you have finalized your Application and Review forms, email support@ecivis.com in the 

following format: 

 

Subject: Solicitation Ready to Publish 

Body: 

- Program Name 

- Primary Workspace owner email 

- Agency/Department name 

- Desired publish date/time* 

*by default programs will be published within 3 hours of the request. Only include a 

desired published date if it is more than 3 hours 

 

 

NOTE: You will need to notify eCivis support also if you make any updates to your forms at any time. 

Any new form fields will need to be activated to appear on applications. 

 

The eCivis support team will notify you when the solicitation has been published and will provide the 

external solicitation link and reviewer portal link. You will also receive a system email notification: 
 

 

You can always check the status of your program on the Program Dashboard in eCivis. The 

solicitation will move the “Published” status in the program list when this is ready: 
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7. Sharing Your Solicitation 

7.1. Sharing Your Public Solicitations Listings Page 
The Public Solicitations Listings page contains any open programs that are marked “Public” 

and can be shared as a department-specific listing or organization-wide listing. 

1) In the Program Dashboard located under the Grant Management menu, return to 

Subrecipient Management. 

 

2) At the top of your page, click the Public Solicitations Listings Page button: 

 

 

3) Select either a department-wide listings page or organization-wide listings page: 

 

 

4) Click the Solicitations Listing Page button to visit the page, or click the Copy Listings 

Page Link button to copy a link to share: 

 

 

5) The page will display only open programs. Each program name is a hyperlink to the 

specific external solicitation page: 
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6) To embed the listings page in an existing webpage, typically for your organization’s 

website, use the iFrame link provided. You can access this by clicking the Copy 

Hosted Listings Link (iFrame) button: 

 
 

 

7.2. Reviewing and Sharing an External Solicitation Page 
You should receive the link to your solicitation by email from eCivis but you can follow the 

steps below to access this page at any time 

1) In the Program Solicitations table, find the name of your program, and click the 

Actions button: 

 

 

2) Click “View Detail”: 
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3) In the Program Detail Page, click the Ext. Solicitation Listing button: 

 

 

4) Review your solicitation by clicking through all tabs to ensure all details are correct: 

 

 

5) Copy and paste the URL that displays in your browser. This is the same link that is 

shared with you when eCivis support completes publishing your solicitation: 

 

 

6) Applicants will click the Apply button to open Portal and begin their entry. When your 

application end date arrives, this button will disappear: 
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8. Monitoring the Application Process 
Once you are logged into your application workspace, click on the Data tab to see the status of all of 

your applications. The Data tab contains dynamic feedback of each application from the early stages 

of draft, under review, awarded, etc. It also provides you will relevant data captured in each of those 

stages: 

 

8.1. Re-Opening an Application to Draft Status 
1) From the Data tab you will see the status of all of your applications. You can change 

the view of your table by selecting “View: Submissions by Folder.” 

 

Select the submitted application that you want to move back into a draft status: 

 

 

2) The current status of the application will be in the upper right corner of the 

application form. Click on the status button and select “Draft” from the dropdown 

menu, and click the Save button at bottom left of the application form: 
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8.2. Running Ad Hoc Reports on Application Data 
1) From the Data tab you will see the status of all of you applications. You can filter 

what applications and applications data will be displayed in the table through two 

filters: 

 

 

2) The first is the Filter icon: 

 

 

This tool allows you to use conditional rules to filter data captured in the application 

form as well as the application status and some profile information: 

 

 

3) The second is the Show/Hide Columns icon: 

 

 

This tool allows you to select any data points captured during the application process 

which include data fields from the profile form and subsequent scoring data once the 

application has been reviewed. Columns can be moved and data sorted even as 
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needed: 

 

 

4) You can then select to export your current table view or all available data points 

available in the Show/Tool. Data will export to a .CSV file format: 

 

 

 

 

8.3. Printing Applications and Associated Documents 
You have a print option available for every application form and any associated documents 

linked to the application. 

1) From the Data tab you will see all of you applications. Select the application that you 

want to print. In the upper right corner of the application form select the printer icon: 
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2) You will see a print preview. Click the Print button to continue: 

 

8.4. Contacting Your Applicants in Zengine 
1) From the Data tool in your workspace click the Email icon: 

 

 

2) This form will allow you to select and filter recipients and also allow you to pull data 

fields in from their profile and application form: 
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9. Assigning Reviewers to Submissions 

9.1. Reviewer Portal URL 
When you email support@ecivis.com to publish your grant program, you will be notified when 

it is available and also sent the link to access the reviewer portal. 

Example: https://webportalapp.com/portal/applications_example 

Once you have added your reviewers and assigned applications appropriately, this link can be 

distributed to the reviewers to begin the review process. 

 

 

9.2. Adding/Editing Application Reviewers 
1) Reviewers will automatically be transferred from the Review tab in Grants Network: 

 

 

2) You can remove a user by selecting the red trash can icon in Grants Network: 
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9.3. Assigning Applications to Reviewers 
1) Log into your Zengine account. 

 

2) Select the workspace title that matches the program title you wish to access: 

 

 

3) Select the Reviewers tab: 

 

 

4) To assign applications to reviewers, click the Program Manager (flag icon) at the top 

of the page: 

 

 

On the following page, click Edit Assignments: 

 

5) Assignments can be made by submission, group, or member. Select the method of 

assignment in the top left corner: 
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6) After selecting your assignment method, choose the submission, group, or member 

on the left side and the submission, group, or member it will be assigned to on the 

right: 

 

 

9.4. Re-Opening a Review 
If a reviewer needs to edit a review that has already been submitted, you can re-open it for 

them. 

1) To reopen a review that has already been submitted, go to the Review tab. Select the 

review you need to change: 

 

 

2) Next, on the top right hand side of the page select Revert to Draft: 
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10. Reviewing Feedback/Scores 
There are two primary forms where you can begin reviewing each reviewer’s application feedback and 

scores. 

1) First, select the Review form. This form contains the feedback and category scoring 

submitted by the reviewer for each application they were assigned to review. 

 

 

2) The default view is to group reviews by status (not started, in progress, or submitted). 

However, you can regroup by application and by reviewer. To change your view click on the 

“View” drop-down menu and select the desired view: 

 

 

3) The applicant’s total score can be seen in the Total Score column. Use the bar at the bottom 

to scroll left and right: 

 

 

The second form to review is the Application form. On the Application form, each applicant’s 

average score is included at the bottom of each record. Use the bar at the bottom to scroll 

left and right: 
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10.1. How to run ad hoc reports on review data 
From the Data tab you will see the status of all of you reviewer evaluations. You can filter 

what evaluation and evaluation data will be displayed in the table through two filters. 

 

 

1) Click on the Filter button: 

 

 

This tool allows you to use conditional rules to filter data captured in the evaluation 

form as well as the evaluation status and some profile information. 

 

 

2) Click on the Show/Hide Columns button: 
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This tool allows you to select any data points captured during the application and 

review/evaluation process which include data fields from the profile form and 

subsequent scoring data once the application has been reviewed. Columns can be 

moved and data sorted even as needed. 

 

3) You can then select to export your current table view or all available data points 

available in the Show/Tool. Data will be exported in a .CSV file format, which you can 

then report on in whatever format you need to. 

 

 

 

10.2. Contacting Reviewers 
1) From the Data tool in your workspace select the Email icon: 

 

 

2) This form allows you to select and filter recipients, and also allows you to pull data 

fields in from their profile and application form: 
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3) You can send an email to all Reviewers by clicking the drop-down menu for 

“Recipients Form,” and selecting “Reviewers”: 
 

 

4) Select the email address field for recipients in the “Email Field” drop-down. This is 

from where you are taking the email address for your Reviewers: 
 

 

NOTE: In most cases, “Profile: Email” will be the correct choice. 

 

5) Add a “From Name,” “Reply To” email address, “Subject,” and “Body” of your email: 

 

6) If you wish to send your email immediately, click the Send Now button in the lower 

right corner: 
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However, if you wish to schedule the email to automatically send at a later date 

and/or time, click the Schedule Email button. 

 

This will open a pop-up that lets you select a date and time for the email to be sent: 

 

 

Fill out the desired send date and time, and click the Save + Continue button. 

mailto:support@ecivis.com


P a g e | 

71 

Customer Success | 418 N. Fair Oaks Ave., Ste. 301| Pasadena, CA | (877) 232-4847 | support@ecivis.com 

 

 

11. Making Award Recommendations and Denials 

11.1. Making an Award 
The subrecipient will not be notified of their award until the Award Recommendation 

Approval task has been completed. They will see their application as Under Review in their 

Portal. 

1) After you have completed the review/scoring process and have determined who 

receive an award, select the application to be awarded: 

 
 

2) Select the folder drop down and change Under Review to Recommend Award: 

 

3) At the bottom left of this window, click the Save [Application Name] button: 

 

 

4) Log into Grants Network and from the Grant Management tab, select “Subrecipient 

Management”: 
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5) From the list of programs, click “Actions,” and select “View detail”: 

 

 

6) The applicant that was moved into the Recommend Award folder in Zengine will now 

appear under Pending Awards Awaiting Recommendation: 

 

7) From the row of the appropriate applicant, select “Create Recommendation”: 
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8) Complete all available information on the following page: 

 

 

NOTE: The External Note will be viewable by the Subrecipient. The Internal note will 

be for Approver use only. 

 

9) Attach any applicable files. 

 

Award notification files will be sent to the applicant as detailed notifications of their 

award details. 

 

Award Files will be included as part of the files that the applicant will have to 

reference or fill in order to accept their award. 

 

 

10) To review or revise the applicant’s budget, select Award Budget. 

 

11) Edit the Award Recommendation Total by identifying each distribution per funding 

source: 
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12) Confirm or redefine the Financial Report task schedule that you will assign to the 

subrecipient: 

 

 

13) Confirm or redefine the Activity Report task schedule that you will assign to the 

subrecipient: 
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14) Once you have completed all fields, click the Send for Approval button: 

 

 

15) Once the recommendation has been created, the applicant will have been moved 

from the Pending section. It will now display on the Award Recommendation 

Approval task list for the first (if not only) individual in the Award Recommendation 

approval workflow set up from the Edit Solicitation page: 

 

 

11.2. Making a Denial 
1) After you have completed the review/scoring process and have determined who will 

NOT be awarded, open the Denials form. 

 

 

2) Select the Add Denial button on the top left side of the page to begin entering a 

denial: 

mailto:support@ecivis.com


P a g e | 

76 

Customer Success | 418 N. Fair Oaks Ave., Ste. 301| Pasadena, CA | (877) 232-4847 | support@ecivis.com 

 

 

 

 

 

3) On the Denial form, complete the following fields: 

Submission: Select the application you want to deny. 

External Message: Enter a message for the denied applicant. 

4) After all applicable fields have been updated, click “Save New Denial” at the bottom of 

the form. 

 

 

5) After saving the new denial, an email will be sent to the applicant notifying them of 

the denial including the External Message. 
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12. Initiating a Direct Award 
In some circumstances, you will not require applications in order to award grant funds. In these 

cases, you can initiate a direct award. This is also referred to as the “Simplified Award Process.” 

12.1. Creating a Simplified Subaward Solicitation 
To award funds directly, you must create a solicitation that can support direct funds. This is 

called a Simplified Subaward Solicitation. 

1) Hover over the Grant Management Tab in Grants Network, and click on Subrecipient 

Management: 

 

 

2) Click on the “Add New Program” button: 
 

 

3) A pop-up will appear. Enter the name of your program, select Simplified Subaward 

Process, select the department under which this solicitation falls, and choose 

whether the solicitation will be Public or Private: 
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NOTE: You must select “Simplified Subaward Process” to initiate direct funds. 

 

4) Click “Create Program.” 

 

5) Fill in the necessary solicitation details. For more information on how to complete 

this, see section 4.2. in this guide. 

 

6) Click “Publish Solicitation.” 

 

12.2. Initiating a Direct Award 
Once your solicitation has been completed, you are ready to award funds directly to 

organizations. 

1) Go to your solicitation page, and click “Initiate Direct Award”: 
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2) A pop-up will appear. Fill in the subrecipient’s email address, the Project title, and add 

a note that explains the email they will receive. 

 

 

NOTE: The award can be sent to any email address because the recipient will need to 

sign into his or her Portal account to accept the award. This means you can send 

emails directly to recipients, even if their email is different from the email address 

connected to their Portal account. 

 

You do not need to use the email address that the subrecipient uses for their Portal 

account. 

 

In the external note, you can enter dynamic text, so you can resize, bold, italicize, and 

edit the text to look how you wish. 
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3) The subrecipient will receive an email like this: 

 

 

4) When the subrecipient clicks on the “Inititate Direct Award” link in the email, he or she 

will be taken to Portal. Once they sign-in, they will enter basic information, and click 

Continue: 
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5) The subrecipient will be asked if they are sure they entered the correct information. 

They will confirm by clicking OK. 

 

6) After the confirmation above, the subrecipient will be taken to a Portal dashboard and 

see the following confirmation message, and will see the award listed in their “My 

Awards” section. 
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